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Vocaloid Demo Version

User’s Manual

Welcome To Vocaloid!

This VOCALOID Demo Version will allow you to try out the basic functions of Vocaloid to

discover the many advantages of using this unique piece of software.

However, there are some restrictions and limitations in the functionality of this VOCALOID Miriam

Demo Version. To gain full functionality you will have to purchase the VOCALOID Regular Version in

which you can create vocal tracks using any lyrics you wish, in a wide range of musical styles, using a

number of voices.

First, enjoy listening to the Demo songs by selecting from the menu "File" -> "Open Demo File".
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2-7. Using VOCALOID With Other Music Applications

System Requirements
Minimum System
• Windows XP or Windows 2000.

• Pentium III, 1 GHz or faster.

• 512MB of RAM or more.

• Approx100 Mb Hard disk space or more (For the VOCALOID Regular Version, at least 500 Mb

is required).

• CD-ROM or DVD-ROM drive.

• SVGA Display (1024x768).

• Sound Card with Microsoft DirectSound Compatible driver.

Recommended System
• Windows XP.

• Pentium 4, 1.7 GHz or faster.

• I GB of RAM or more.

Notes & Precautions
• ReWire™ is a product of Propellerhead™ Software. ReWire and Propellerhead are trademarks

of Propellerhead Software.

• VST is a trademark of Steinberg Soft- und Hardware GmbH.

• Windows is a trademark of the Microsoft Corporation.

• Neither the Yamaha Corporation or its subsidiaries will respond to inquiries regarding this

owner’s manual or the operation of this software.

Getting Started
Launch the Application
After installation, double-click on the Vocaloid icon to launch the VOCALOID Demo Version.
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Play the Demo
Select “Open Demo File” and double-click on one of the demo files in the “Demo” folder. Once

the demo file has loaded you can start playback (see 1-2 The Buttons and Indicators -> Transport).

Enjoy!

Creating and Playing a Vocal Sequence – Basic Procedure
Here are the steps of one example you might use to create a short vocal phrase:

Step 1: Create a New Sequence
A new “empty” sequence will automatically be created for you.

Step 2: Set the Initial Tempo and/or Time Signature
You will see the initial tempo and time signature settings at the beginning of the TEMPO and

BEAT rulers above the sequence window, respectively. You can double-click on either of these

numbers to change their value as required (see 1-3. Sequence Window -> Rulers).

Step 3: Enter the Notes

Click on the pencil tool button to select it (see 1-2. The Buttons & Indicators -> Tools). Start

entering the notes at measure number 1 in the sequence track:
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You can click and drag the notes to the required length, but it is easier to use the VOCALOID

Grid and the preset note lengths. (see 2-2. Entering & Editing Notes -> Grid vs. Length).

Step 4: Enter the Lyrics

Now, let’s enter the phrase “I love you my baby”. Go back to the tool buttons and select the

pointer tool. Double click the default lyric “ooh” above the first note to enter the lyric editing

mode and enter the first word “I”. Repeat this for the remaining five notes, entering one word per

note (see 2-3. Entering & Editing Lyrics).

Step 5: Phoneme Transformation

After you enter the lyrics, click the Phoneme Transformation button (see 1-2. The Buttons &

Indicators -> Phoneme Functions) to convert the lyric text into data that VOCALOID can sing.

Step 6: Play – Initial Check
Click briefly in the MEASURE ruler at the appropriate location (see 1-3. The Sequence Window -

> Rulers), and then start playback to hear how it sounds.

Step 7: Add Expression
If the icon palette is not already showing, select VOCALOID Icon Palette from the View menu

(see 1-1. The Menus -> View). Now you can simply drag some basic expression objects to your

vocal track. Start with attack: drag the “ACCENT” attack icon to the first note – when you drop

the icon on the note you should see a little attack object at the beginning of the note, like this:

Now for some vibrato: drag the NORMAL vibrato icon onto the first note and also to the last note.
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The vibrato objects are automatically applied to the last half of the note on which they are placed,

so you will need to grab the leading edge of the vibrato objects and stretch them to the right length

with a red double-headed arrow ( ) (see 2-5. Adding Expression).

Step 8: Add Control
For the final touch to our first track – some real-time control, start by selecting “Brightness” from

the control menu, click the [FREE] control entry mode button (see 1-4. The Control Track ->

Control Input Mode Selectors), and use the pencil tool to draw a curve:

Next select “Gender Factor” from the control menu and draw a curve:

Find out more about it in 2-6. The Control Track -> Editing a Control Track.

Step 9: Play – Check the Expression
Now, play the track again and hear how it sounds.

Step 10: Add a Track
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If you want to make a chorus sequence, add a new track to your sequence by selecting “Add” from

the Track menu (see 1-1. The Menus -> Track). You can now select either of the two tracks for

editing by clicking the track selectors at the bottom of the sequence window (see 1-3. The

Sequence Window -> Sequence Track).

For now, delete the track you just edited by first clicking its track selector and then selecting

“Delete …” from the Track menu. Click [Yes] in the confirmation window to delete the track.

(A VOCALOID Demo Version sequence is limited to 3 separate tracks. The VOCALOID Regular

Version can have as many as 16 separate tracks.)

Step 11: Copy Track 1 To Create a Chorus
Here’s a quick and easy way to create a chorus. Select track 1 (the initial “I love you my baby”

track you created above), and select “Copy” from the Track menu. You will now have a new track

containing the same data as your original track.

Next you can change the pitches of the notes to create harmonies by simply dragging them up or

down the appropriate pitches. Here’s a harmony track that works with our original track:

You will also probably want to adjust the second singer’s attack, vibrato, and other parameters to

give her some individuality while maintaining the best possible musical blend.

Reference Section

1. The Interface
1-1. The Menus
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File

New
Creates a new VOCALOID sequence file.

Open
(This function is disabled in the VOCALOID Demo Version.)

Open Demo File
Opens an existing VOCALOID Demo file. You can listen to the demo and then if you

wish, edit some or all of the parameters in the VOCALOID Demo Version.

Save
(This function is disabled in the VOCALOID Demo Version.)

Save As …
(This function is disabled in the VOCALOID Demo Version.)

Export > Wave File
This function exports the current sequence as a standard wave-format (WAV) audio file.

Recent File
(“Recent File” menu is not showed in the VOCALOID Demo Version.)

Exit
Click “Exit” to exit from the VOCALOID Editor application.
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Edit

Undo
If you make an edit and then decide you want to undo it, use the Undo function

immediately after performing the editing and before performing any other operation.

Redo
This item will “redo” a previously undone edit.

Cut / Copy / Paste
 Cut or copy an object, or a group of objects, that you have highlighted in the sequence

track and the control track and paste the object(s) elsewhere in the track.

Select All
This item will select all data objects in both the sequence track and the control track.

Delete
Deletes the currently selected data object(s).

View
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VOCALOID Icon Palette
Shows or hides the VOCALOID Icon palette which provides access to a variety of

expression objects that can be applied to your sequence (see 2-5. Adding Expression).

VOCALOID Mixer
Shows or hides the VOCALOID mixer window that contains mix controls for each

individual track within the sequence as well as a master level control.

Grid Line
Shows or hides grid lines corresponding to the currently selected grid size in the sequence

track. The grid lines can serve as a useful visual guide when entering or moving notes.

Lyrics / Attack / Phoneme / Vibrato / Dynamics
Shows or hides the corresponding data objects in the sequence track.

Job

Normalize Object …
Resolves all instances of overlapping notes in the current track by shortening the first note

of all overlapping pairs.

Verify Data …
This simply searches the track, and returns the position indicator to the location in the

track of the first note or dynamics object where an overlap occurs so you can fix the

situation as required.

Dynamics Mode …
(This is disabled in the VOCALOID Demo Version.)
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Track

(In the VOCALOID Demo Version, only 3 tracks are available, but in the VOCALOID Regular

Version, one sequence can have up to 16 different tracks.)

Rename
Allows a new name to be entered for the current track.

Copy
Creates a copy of the current track with the same name as the source track.

Add
Creates a new empty track with the default track name.

Delete …
Deletes the current track.

Overlay
Determines whether or not to see the notes in hidden tracks in the current track window.

Lyrics

Phoneme Transformation
Transforms the text lyrics entered or edited into phonetic data that can be sung by the

VOCALOID application. Phoneme Transformation must be executed whenever new
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lyrics are entered or existing lyrics are edited (see 2-4. Phoneme Functions -> Phoneme

Transformation).

Phoneme Edit …
This function is disabled in the VOCALOID Demo Version, but the VOCALOID Regular

Version allows you to edit the individual phonemes of any notes in your sequence.

User Word Dictionary
This function is disabled in the VOCALOID Demo Version.

Setting

VOCALOID MIDI >
Resolution …
This function is disabled in the VOCALOID Demo Version.

Option …
You can change the  “Pre-send Time.”   

AUDIO >
Synthesis Engine …
Only 44.1kHz is available as the sampling rate in the VOCALOID Demo Version,

but in the VOCALOID Regular Version you can also choose 48kHz and 96kHz.
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Device …

Select the audio device to which you want to send the VOCALOID output via

the “Output Device” selection menu. Select stereo or mono output from the

“Channel” parameter.

Wave …
You can specify whether only the current track is exported (“Current”), or all

tracks are exported as a single WAV file (“Master”). When "Mono" is selected a

mono file is exported, although the output level of each track will depend on the

setting of the pan control in the mixer window (see 1-6. The Mixer Window).

Play …
Only “Play After Synthesis” mode is available in the VOCALOID Demo Version, but the

VOCALOID Regular Version has a “Play With Synthesis” function that allows the song to

play immediately once the play button is pressed.

Pre-measure (f) …
You can specify from 1 to 8 “pre measures” before measure 1 in the sequence window.

Skin >
You can change the appearance of the VOCALOID interface.

Customize …
This is disabled in the VOCALOID Demo Version.
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Grid >
To easily enter notes right on the beat, you can chose note “sizes” from 1/4 notes to 64th

notes, plus triplet variations. (see 2-2. Entering & Editing Notes -> Grid vs. Length).

Length >
“Length” determines which beats the end of notes or expression objects will snap to when

stretched. (see 2-2. Entering & Editing Notes -> Grid vs. Length).

Singer List …
This is disabled in the VOCALOID Demo Version, but the VOCALOID Regular Version

has singer choices (if you purchase more than one Vocal Font) and a range of parameters

you can use to customize the singer’s voice.

Help

Contents and Index
Calls up the Contents and Index listings for the VOCALOID on-line help file.

About VOCALOID Editor …
Brings up the VOCALOID splash screen containing information about VOCALOID.

1-2. The Buttons & Indicators
File Functions

These buttons provide direct access to the file functions – New, Open, and Save. (The VOCALOID

Demo Version only has access to the “New” function.)

Edit Functions
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These buttons provide direct access to four of the edit functions – Undo, Redo, Copy, and Paste.

Tools

Pointer
The pointer tool is used to select already-entered notes and control points for editing.

Pencil
The pencil tool is used to enter new notes, tempo or beat changes, and controller data.

Eraser
As its name suggests, the eraser is used to erase any data object you click on.

Note Values

Note Length
When a note length is selected, a note of the specified length will be placed at the point at

which you click using the pencil tool.

Triplet
Modifies the selected note length to produce triplets.

Dotted Note
Modifies the selected note length to produce dotted note values.

Phoneme Functions

Phoneme Transformation
Click this button after entering new lyric text in the sequence to transform the text into

phoneme data (see 2-4. Phoneme Functions – Making VOCALOID sing).
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Phoneme Edit
(This is disabled in the VOCALOID Demo Version, but is available in the VOCALOID

Regular Version. It allows you to assign a range of phonetic symbols to your lyrics.)

Show/Hide Start and End Markers

(This is disabled in the VOCALOID Demo Version, in the VOCALOID Regular Version,

these buttons individually activate or deactivate the start and end markers in the

MEASURE ruler.)

Transport

To Top 
Click to go directly to the beginning (top) of the track.

Fast Reverse 
Scrolls backward through the track while held, or steps backward in one-measure

increments if clicked briefly.

Stop 
Stops playback.

Play 
Begins playback. Playback will stop automatically at the end of the track.

Fast Forward 
Scrolls forward through the track while held, or steps forward in one-measure increments

if clicked briefly.
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To End 
Click to jump directly to the end of the track.

Repeat  
(This is disabled in the VOCALOID Demo Version.)

Grid

The “grid” makes it easy to enter notes right on the beat.

Size
Select the size of the notes you want to align the grid to: 1/4, 1/8, 1/16, 1/32, 1/64.

Triplet
If the triplet button is lit the currently selected note becomes the corresponding triplet

size.

Grid Off
If this button is engaged notes can be positioned with maximum resolution.

Length

“Length” adjusts alignment of the size of notes and expression objects entered.

Size
Select the beats you want to align note sizes to: 1/4, 1/8, 1/16, 1/32, 1/64.

Triplet
If the triplet button is lit the currently selected note becomes the corresponding triplet

size.
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Length Off
When the Length OFF button is engaged no alignment occurs and the ends of notes and

expression objects can be positioned with maximum clock resolution.

Coordinate Indicators

These two values tell you exactly where your cursor is located in the VOCALOID sequence track.

X
The “X” coordinate indicates the current horizontal position Measure : Beat : Clock along

the sequence track (see 1-3. The Sequence Window -> Sequence Track).

Y
The “Y” coordinate indicates the current vertical position. It ranges from C-2 to G8.

Tempo Indicator

Shows the current sequence tempo.

View Selectors

These buttons let you show or hide the LYRICS, PHONEME, ATTACK, VIBRATO, or

DYNAMICS data in the sequence track.

1-3. The Sequence Window
Rulers

The “rulers” across the top of the sequence track control the track’s time-based functions.
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Measure
The indicator scrolls along the track during playback to indicate the current position.

Tempo
Click on the TEMPO ruler with the pencil tool to edit its value and the precise position.

Beat
Click on the BEAT ruler with the pencil tool to edit the upper and lower values.

Sequence Track
This is where you actually enter the notes and lyrics to be “sung” by VOCALOID.

Zoom Buttons 

The [ ] and [ ] zoom buttons zoom in or out on the track horizontally.

Track Selector Tabs
Track selector tabs for all tracks you have created in your VOCALOID sequence will

appear here. Select a track for editing or viewing by clicking the corresponding tab.

Track Scroll Buttons

Use the track scroll buttons to scroll the desired track tab into view ([ ] and [ ]), or

to jump to the beginning or end of the track selector tabs ([ ] or [ ]).

1-4. The Control Track
The control track is where you view and edit all parameters that control the sound of the notes in

the sequence track: note velocity, harmonics, pitchbend, and more.



Vocaloid Demo Version User’s Manual

- 19 –

Copyright© 2004 by YAMAHA Corporation

Control Select
Click the arrow [ ] to select the control parameter. One control parameter can be displayed at a

time, but all programmed parameter changes are active at all times.

Value
The current value of the selected control point or parameter is displayed in the VALUE bar.

Interval
This parameter determines the spacing of the control points generated by the “free” or “line”

input, below. It does not affect the “dot” input mode.

Control Input Mode Selectors
Choose the input mode that most easily produces the type of control change or curve you need.

Dot
Click at the desired location in the control track to enter single control values

individually.

Free
Click and drag to create virtually any control curve in order to create complex control

changes.

Line
A straight line with multiple control points is created when you hold and release the

mouse button.

1-5. The Icon Palette
Check the VOCALOID Icon Palette in the View menu to show a movable floating palette which

provides access to expression types that can be applied to your sequence (see 2-5. Adding

Expression). The Icon Palette in the VOCALOID Demo Version includes the following items:

 Attack: Accent, Legato, Slow Bendup
 Vibrato: Normal, Extreme
 Dynamics: Forte, Piano
 Crescendo: One linear crescendo
 Diminuendo: One linear diminuendo
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1-6. The Mixer Window
The movable floating VOCALOID Mixer window will appear by selecting from the View menu.

It provides mix controls for each track within the sequence as well as a master level control.

The Icon Palette in the VOCALOID Regular Version includes:
- Attack: Tenuto, Accent, Extreme Accent, Legato, Fast Bendup, Slow

Bendup, Trill Whole, Mordent Semi, Mordent Whole
- Vibrato: Normal, Subtle, Slight, Deep, Very Deep, Extreme
- Dynamics: Pianississimo, Pianissimo, Piano, Mezzo Piano, Mezzo Forte,

Forte, Fortessimo, Fortessissimo
- Crescendo: 3 different intensities for linear crescendo and 2 different

intensities for swell-type crescendo.
- Diminuendo: 3 different intensities for linear diminuendo and 2 different

intensities for swell-type diminuendo.
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Track Fader
Drag the fader up or down to adjust the level of the corresponding track.   

Pan Control
The pan control for each track is the horizontal “L—R” slider. Drag the slider to the left

or right to pan the signal from that track to the corresponding side of the stereo output.

Mute Button
Click the [MUTE] button at the top of any module to turn the output from that track off.

Solo Button
You can simply engage the [SOLO] button for one track to mute all the others.

Output Assign
The selector at the bottom of each track module assigns the output of that track to either

the master fader or ReWire™. (ReWire™ function is not available in the VOCALOID

Demo Version.)

Master fader Module
The master fader in the fader module controls the overall output level of all VOCALOID

tracks that are assigned to “Master.”

2. Operation
2-1. The Singer
You can change and customize the singer in the VOCALOID Regular Version, but this function is

not available in the VOCALOID Demo Version.

2-2. Entering & Editing Notes
The first step to create any VOCALOID sequence, enter the desired notes (pitch and length) in the

sequencer track (see 1-3. The Sequence Window -> Sequence Track) using the pencil tool.
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If no note length is selected, click and drag the notes as required at the appropriate pitches, but if a

note length is selected, a note of the specified length will be placed at the point at which you click

(also subject to the current Grid setting). Keep in mind that notes in the same track cannot overlap.

Deleting Notes
You can individually delete notes either by clicking on them with the eraser tool, or single-

clicking them and pressing the [Delete] key on your computer keyboard

Stretching Notes
The Length setting (see 1-2. The Buttons & Indicators -> Length) determines the beats to which

the note release will snap when a note is stretched. Place the pointer tool over the end of a note so

that the red double-headed arrow appears ( ), and click and drag the note to resize as required.

Moving Notes
Position the pointer tool over the body of a note until you see the hand pointer and click and drag

the note to a different horizontal or vertical position. The Grid setting (see 1-2. The Buttons &

Indicators -> Grid) will determine to which beats the moved note(s) will snap.

Copying Notes
You can copy single notes or a group of highlighted notes to a different location (time and/or

pitch) by grabbing and dragging with the hand pointer while holding the [Ctrl] key.
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You can also use the standard edit commands – cut, paste, and copy (see 1-1. The Menus -> Edit)

In this case the notes will be pasted to the current location of the position indicator.

Grid vs. Length
The Grid setting affects where the beginnings of the notes or expression objects are placed,

whereas the Length setting applies to the ends (releases) of notes and expression objects in the

sequence track.

2-3. Entering & Editing Lyrics
The default lyric “Ooh” is automatically entered for each note. Double-click on and edit the

default lyric for each note to create the desired phrase. You can press the [TAB] key to jump

directly to the next note after entering the text for a note.

In some cases a single word will correspond to a single note, but in many cases words will be sung

across two or even more notes, one syllable per note. In such cases simply type a hyphen

following the syllable that needs to connect to a syllable on the following note.

In the above example, the first four words (“I love you my”) correspond to individual notes, while

“ba-by” is sung using two notes: the “ba-“ syllable on the first and the “by” syllable on the second.

2-4. Phoneme Functions – Making VOCALOID Sing
The VOCALOID phoneme functions are the critical functions that turn typed lyric text into

synthesis data that pronounces the lyric when played back.

Phoneme Transformation
Whenever you enter or edit the lyric text at any stage during the track creation, generate the proper

pronunciation either by clicking the “Phoneme Transformation” item in the “Lyrics” menu, or by

clicking the Phoneme Transformation button.
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Phoneme Editing
This option is disabled in the VOCALOID Demo Version, but the VOCALOID Regular Version

lets you change the actual phoneme transformation results for the note(s) if the normal

transformation doesn’t produce the pronunciation you require.

The User Word Dictionary
The VOCALOID Demo Version comes with a basic dictionary that produces appropriate

pronunciations for most lyrics, but the VOCALOID Regular Version also allow you to enter any

additional words in the VOCALOID User Word Dictionary to match your lyrical requirements.

2-5. Adding Expression
Basic expressive variations can be added to your sequence by dragging and dropping the

appropriate icons from the VOCALOID Icon Palette (see 1-5. The Icon Palette). Click the

VOCALOID Icon Palette item in the View menu (see 1-1. The Menus -> View) to make the icon

palette visible.

Vibrato
Vibrato is added to individual notes by dragging the icon corresponding to the desired type of

vibrato onto the note to which it is to be applied. Initially the vibrato will be applied to the latter

half of the note, simulating the way a singer normally applies vibrato only to the last part of a

note.

Editing Vibrato Objects
Double-click on any vibrato object that has been applied to the sequence to bring up its edit

window.



Vocaloid Demo Version User’s Manual

- 25 –

Copyright© 2004 by YAMAHA Corporation

 

Variation…
This button allows you to change the current vibrato object to a different vibrato type.

Position
You can numerically specify the position (measure:beat:clock) of the beginning of the

vibrato object within the boundaries of the note. The maximum possible setting,

dependent on the note length, is shown to the right of the position parameters.

Duration
Duration specifies the length (duration) of the vibrato. The maximum possible setting,

dependent on the note length, is shown to the right of the duration parameters.

Depth
Open the graphic vibrato depth editing window by clicking the Depth [Setup…] button.

The depth of vibrato can be dynamically varied over its duration. The depth range is from

0 to 127, with 64 as default. You can add control points (dot, free or line) at any locations

within the white area of the window corresponding to the duration of the vibrato object.

Rate
Open the graphic vibrato rate editing window by clicking the Rate [Setup…] button.

The rate (speed) of vibrato can be varied from 0 to 127 (fastest), with 64 as default.

Comment
The comment space can be used to enter a text comment describing the object.
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Attack
Attack objects are added to the beginning of individual notes by dragging the icon corresponding

to the desired type of attack on to the note. These can be moved or copied to other notes in the

same way as vibrato objects, but cannot be stretched or moved within the note.

Editing Attack Objects
Double click any attack object that has been applied to the sequence to bring up its edit window.

Variation…
This button allows you to change the current attack object to a different attack type.

Duration
Duration specifies the length of the attack. The range is from 0 to 127.

Depth
Like the Duration parameter, Depth has a range of 0 to 127, with a default setting of 64.

Comment
The comment space can be used to enter a text comment describing the object.
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Dynamics
Dynamics objects can be placed at any point in the sequence window by dragging and dropping

from the VOCALOID Icon Palette. Dynamics do not have to be dropped on specific notes

however dynamics objects cannot overlap each other within the same track.

Editing Dynamics Objects
Double click any dynamics object applied to the sequence to bring up its edit window.

Variation…
This allows you to change the current dynamics object to a different dynamics type.

Dynamics
The level of each dynamics object can be adjusted via the Dynamics parameter. The

available ranges are shown in the drop-down menu.

Comment
The comment space can be used to enter a text comment describing the object.

Crescendo & Diminuendo
The crescendo and diminuendo objects can be placed at any point in the sequence window by

dragging and dropping from the VOCALOID Icon Palette and can span any number of notes.

Editing Crescendo & Diminuendo Objects
Double click any crescendo or diminuendo object applied to the sequence to bring up its edit

window.
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Variation…
This button allows you to change the current crescendo or diminuendo object to a

different crescendo or diminuendo type.

Duration
Duration specifies the length of the crescendo or diminuendo object. The maximum

possible setting is shown to the right of the position parameters.

Dynamics
The overall shape of the level change produced by each crescendo or diminuendo object

can be dynamically varied from -127 to +127 over its duration.

Comment
The comment space can be used to enter a text comment describing the object.

Creating Custom Expression Icons
Once you edit an expression object, you can add the edited object to the VOCALOID Icon Palette

for convenient access later by right-clicking on the object in the sequence track and clicking “Add

to Icon Palette” in the pop-up menu. This brings up the “Setup Icon name” window in which you

can enter a name for your icon, and add a comment. The new icon will be added to the appropriate

row in the VOCALOID Icon Palette with a “U” in the upper left corner as a “User” icon.
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To delete a custom icon, single-click the icon to highlight it, then press the [Delete] key on your

computer keyboard. Click [OK] in the confirmation window, and the icon will be deleted.

2-6. The Control Track
The control track can be used to create dynamic changes in parameters. A control change

corresponds to the measure:beat:clock location and object immediately above it in the sequence

track. The range for the selected parameter is displayed numerically to the left of the control track.

Editing a Control Track

Select a Control parameter To View or Edit
You can click the arrow and select one control parameter to be displayed in the control track at a

time, and the name of the currently selected parameter will appear in the control select bar.



Vocaloid Demo Version User’s Manual

- 30 –

Copyright© 2004 by YAMAHA Corporation

Edit Existing Control Points
Use the pointer tool to click and drag existing control points horizontally to change their

measure:beat:clock location and/or vertically to change their value (note velocity control points

can only be moved vertically). You can also select a control point to highlight it and then use the

VALUE increment and decrement arrows to edit the point’s value, or numerically edit the value

by double clicking the currently displayed value and entering a new value.

Create New Control Points
You can create any number of control points for any parameter except note velocity using the

pencil tool. You can enter control points using the DOT input mode or in groups conforming to a

specified curve or line using the FREE or LINE input mode.

The Control Parameters
Note Velocity
A default note velocity is created automatically whenever a note is entered to determine the

individual loudness of each note in the sequence. You can edit and select the note velocity control

points using the pointer tool or use the pencil tool in the FREE or LINE mode to draw a curve or

line through which points the included notes will snap to when the mouse button is released.

Singer Parameters
This option is disabled in the VOCALOID Demo Version, but it is available in the VOCALOID

Regular Version.

Pitch Bend
The control range in the Pitch Bend control track is from –8192 to 8191. With the maximum Pitch

Bend Sensitivity setting the overall pitch bend range allows pitch variation of ±2 octaves.
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Pitch Bend Sensitivity
Determines to what degree pitch bend value changes will affect the pitch. At the maximum setting

of “24” the full value range will produce pitch variation of ±2 octaves.

Singer
This option is disabled in the VOCALOID Demo Version.

2-7. Using VOCALOID With Other Music Applications
Exporting Wave Files
To export your VOCALOID sequence as a WAV (audio) file, select “Wave File …” from the

File/Export menu. Wave file details can be specified in the Settings/AUDIO > Wave … menu (see

1-1. The Menus -> Setting). You can specify whether only the currently selected track is exported

(“Current”), or all tracks are exported as a single WAV file (“Master”). In either case the level and

pan settings in the VOCALOID Mixer window  (see 1-6. The Mixer Window) affect the levels

and stereo position in the exported file. There is also a "Mono" option which creates a mono file to

be exported - the output level of each track will depend on the setting of the level control.

ReWire™ Synchronization
This option is disabled in the VOCALOID Demo Version, but the VOCALOID Regular Version

can be synchronized with any sequencer compatible with the ReWire™ protocol.

The VOCALOID VST instrument
The VOCALOID Demo Version does not include the VOCALOID VST instrument, but the

VOCALOID Regular Version will let you conveniently use VOCALOID as a VST instrument.

Importing MIDI (SMF) Files
This option is disabled in the VOCALOID Demo Version, but the VOCALOID Regular Version

will let you import SMF (Standard MIDI File) files containing up to 16 tracks.


